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1. GRANT OF LICENSE 
TAL Technologies, Inc. grants you the right to use one copy of the enclosed software program (the 
SOFTWARE) on a single terminal connected to a single computer (i.e., with a single CPU). You 
may not network the SOFTWARE or otherwise use it on more than one computer or computer 
terminal at the same time. 
 
2. COPYRIGHT 
The SOFTWARE is owned by TAL Technologies, Inc. and is protected by United States copyright 
laws and treaties. Therefore, you must treat the SOFTWARE like any other copyrighted material 
(e.g., a book or musical recording) except that you may either (a) make one copy of the 
SOFTWARE solely for backup or archival purposes, or (b) transfer the SOFTWARE to a single 
hard disk provided you keep the original solely for backup or archival purposes. You may not copy 
the users manual accompanying the SOFTWARE. 
 
3. OTHER RESTRICTIONS 
You may not rent or lease the SOFTWARE, but you may transfer the SOFTWARE and 
accompanying written materials on a permanent basis provided you retain no copies and the 
recipient agrees to the terms of this Agreement. You may not reverse engineer, decompile, or 
disassemble the SOFTWARE. If SOFTWARE is an update, any transfer must include the update 
and all prior versions. 
 
4. DUAL MEDIA SOFTWARE 
If the SOFTWARE contains both 3.5" and 5.25" disks, then you may use only the disks appropriate 
for your single-user computer. You may not use the other disks on another computer or loan, rent, 
lease or transfer them to another user except as part of a permanent transfer (as provided above) 
of the SOFTWARE and written materials. 
 
5. DISCLAIMER 
No Warranty of any kind on the SOFTWARE is expressed or implied. 
In no event shall TAL Technologies, Inc. or its suppliers be liable for any damages whatsoever 
(including, without limitation, damages for loss of business profit, business interruption, loss of 
business information or other pecuniary loss) arising out of the use of or inability to use this 
product. Should you have any questions concerning this agreement, or wish to contact TAL 
Technologies, Inc. for any reason please write: 
 
   TAL Technologies, Inc. 
   Customer Service Dept. 
   2027 Wallace Street 
   Philadelphia, PA 19130   U.S.A. 
   Tel: (215)-763-5096  Fax: (215)-763-9711 
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Congratulations! You have purchased the most advanced and the easiest to use bar code 
software package available for MS Windows. The Standard Edition of B-Coder has all the features 
necessary to produce professional quality bar codes for all types of applications including product 
packaging, document tracking, Postal bar coding and special purpose bar code labeling 
applications. Not only is B-Coder powerful, but it is extremely easy to use. 
 
The philosophy behind B-Coder is that instead of forcing you to stay within the limits of a bar code 
labeling program, B-Coder acts as a bar code graphics tool for use with other Windows 
applications. With B-Coder you design the printed output or label layout with another program that 
you already know how to use like MS Word, Pagemaker, Quark Express, Windows Write, etc.., 
you then use B-Coder to produce bar codes that are quickly and easily pasted into the other 
program. 
 
Most other bar code software packages are strictly label design programs that force you to use 
their own label design tools. B-Coder on the other hand allows you to incorporate bar codes into 
any Windows application program that you like! 
 
The Standard Edition of B-Coder supports the most commonly used bar code symbologies, it 
allows full selection for both the foreground and background colors, it supports symbol rotation in 
90 degree increments and it allows complete font selection for the human readable text below a 
bar code symbol. Some advanced features include target printer selection, measurement unit 
selection and complete and accurate control over all bar code dimensions. B-Coder's intuitive 
warning messages make it virtually impossible to produce unreadable bar codes no matter what 
type of printer you are using.  
 
 
The Professional Edition of B-Coder adds the following additional features: 
 
1. Support for additional bar code symbologies including CodaBar, Code 93, Code 128, EAN/UCC 
128, PDF417, and BPO 4 State Code. 
 
2. Full Dynamic Data Exchange (DDE) Support. This allows you to control B-Coder directly from 
within other Windows application programs. 
 
3. Support for automatic numeric sequencing or incremental numbering of bar code symbols. 
 
4. Bar code message input from a disk file. 
 
For information on how to upgrade from B-Coder Standard Edition to B-Coder Professional, please 
contact TAL Technologies, Inc. at Tel: 800-722-6004 or (215)-763-5096  Fax: (215)-763-9711 or 
visit our web site at: http://www.taltech.com 
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B-Coder is provided with a "Setup" program that will install the B-Coder program files onto your 
hard disk to a directory that you specify. The setup program also creates a B-Coder program group 
in the Windows Program Manager with the B-Coder program icons in it. 
 
To install B-Coder on your PC, place the B-Coder Setup diskette in your disk drive ( A: or B:). Next, 
open the Windows Program Manager and select Run from the Program Manager's File menu. A 
dialog box will appear where you should enter the command: A:SETUP (or B:SETUP if using drive 
B:). After you press the Enter key the Setup program will prompt you for the name of a directory 
where you would like to install B-Coder and then it will copy all necessary files to the specified 
directory. 
 
 

 
B-Coder is an extremely easy to use program that generates professional quality bar codes in all 
major symbologies and sizes and places them in the Windows clipboard so that they can be 
pasted directly into files or documents created with other Windows programs. Bar codes generated 
with B-Coder may be scaled to any size and can be used by any Windows program that supports 
pasting of Windows MetaFile or Bitmap graphics (i.e. MS Word, Windows Write, Excel, Lotus 123, 
Word Perfect, Micrografx Draw, Pagemaker, Corel Draw, Visio, etc.). 
B-Coder can also be used to generate bar codes and save them to disk in practically every major 
graphics file format including EPS, TIF, GIF, AI, JPG, WMF, DIB, BMP and over a dozen other 
commonly used image types. This makes B-Coder ideal for all desktop publishing applications that 
require bar code images to be incorporated in a document, label or product package design. 
 
B-Coder gives you the ability to quickly incorporate bar codes into any Windows application 
program. Instead of dealing with expensive and complex bar code label design programs, simply 
paste perfect bar codes directly into the programs that you already know how to use and print 
them on any printer supported by Windows (i.e. any standard printer).  
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B-Coder was designed as a bar code generating tool to be used along with other Windows 
programs. The simplest way to use B-Coder is to run both B-Coder and the program that you want 
to paste bar codes into at the same time. When you need to insert a bar code into the other 
program, switch to B-Coder, enter the text that you want represented as a bar code in the B-Coder 
window and select BUILD/COPY from B-Coder's Edit menu. This will create your bar code and 
automatically copy it to the Windows clipboard. Finally switch back to your original program and 
select PASTE from the program's Edit menu. The bar code will appear in the program's window.  
 
Note: Your monitor's resolution may not be high enough to display the bar code exactly as it will 
appear when you finally print the bar code on your printer.  
 
The following samples were all pasted into Microsoft Word and were printed on an HP Laserjet 4 
laser printer. 
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The B-Coder window contains a main menu just below the title bar. A tool bar directly below the 
main menu allows quick access to some of the more useful items in the main menu. Below the tool 
bar, inside the B-Coder window, are several data input fields that allow control over the dimension 
of your bar codes. These fields will differ depending on the features of each chosen bar code 
symbology. For details on all options available in the main menu see the section: The B-Coder 
Main Menu. For details on the fields that control the dimensions of your bar codes refer to: Bar 
Code Dimensions and Symbology Descriptions and Rules.  
 
The Bar Code Message text field in the center of B-Coder's window is where you enter the text that 
you want represented as a bar code. The Comment Line text field allows you to enter an additional 
comment line that is printed either above or below your bar code symbol. 
 
At the bottom of B-Coder’s window is a status area that displays the currently selected bar code 
symbology as well as the total overall width of each generated bar code symbol. The status area 
will also display any check digit values that B-Coder calculates for all bar code symbols that 
include a check digit. 
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Note: If you press the Enter key while editing a bar code message, B-Coder will insert a carriage 
return linefeed pair in your message. These characters will appear as a musical note and a small 
rectangle in the message text. Unless you want a carriage return linefeed in your bar code, you 
should not press the Enter key when finished editing a bar code message. 
 
 
Hint: Double clicking your right mouse button with the mouse cursor on any blank space in B-
Coder's window will delete all text in the Bar Code Message text edit field and the Comment Line 
text edit field. 
 
 
If the bar code symbology that you are using supports characters that cannot be typed in on your 
keyboard, an ASCII chart will also appear so that you can enter all characters in the symbology's 
character set. To enter characters in your bar code text using the ASCII chart, move the text cursor 
in the bar code text edit box to the point where you want to insert a specific character and then 
select the character by double clicking your mouse on it in the ASCII chart. The character will 
automatically appear in the bar code text edit control. You may also select characters from the 
ASCII chart using the arrow keys or scroll bars to scroll the chart and then pressing the Enter key 
to select a hi-lighted character. 
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B-Coder's main menu contains the following sub menus: File, Edit, Preferences, Symbology and 
Help.  
 
 
The File menu contains commands for performing disk file related operations like loading 
configuration files, saving bar code images to a disk file, selection of the target printer that will be 
used to print your bar codes and the Exit command. 
 
 
The Edit menu contains commands for building and copying a bar code symbol, pasting text into 
B-Coder from other programs, editing of incremental numbering parameters and for scrolling 
forward and backward through a sequence of bar code messages. 
 
 
The Preferences menu contains commands that allow you to customize the way that B-Coder 
works including such features as font and color selection, controlling symbology specific options, 
changing the orientation of bar code symbols, selection of measurement units, etc.. 
 
 
The Symbology menu allows you to select the type of bar code to produce. (The bar code 
symbology). 
 
 
The Help menu provides quick access to B-Coder's on line help system. 
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The first four options in the File menu: New, Open Configuration, Save Configuration, and Save 
Configuration As... allow you to create, open and save B-Coder configuration files. When you set 
up B-Coder by selecting all the various parameters necessary to produce the correct bar code 
symbols for your particular application, you can save your settings in a "configuration file" so that 
when you exit B-Coder, you can open your configuration and thus start up where you left off the 
next time you run B-Coder. 
 
NOTE: You can automatically load a configuration file when you start up B-Coder by placing the 
name of a configuration file on the command line used to invoke B-Coder. For example, the 
command line: C:\B-Coder\B-Coder.EXE C:\B-Coder\MyConfig.BCF would cause B-Coder to 
automatically read in and use the config file "MyConfig.BCF" at startup.  
 
The New command in the File Menu causes B-Coder to reset itself to its default configuration. 
 
The Open Configuration command allows you to open a previously saved B-Coder configuration. 
When you select this option, a standard Windows file selection dialog box will appear so you can 
easily select a previously saved B-Coder configuration file. When you open a configuration file, the 
filename will appear in the title bar of the B-Coder window. 
 
The Save Configuration command allows you to quickly save any changes that you make to an 
open configuration and the Save Configuration As... command allows you to save your  
current B-Coder configuration with a filename that you specify. When you choose Save 
Configuration As..., a standard Windows "file save as" dialog box will appear so that you can 
enter the filename and directory path where you would like your configuration to be saved. 
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The Target Printer command allows you to specify the dots per inch resolution of the printer that 
you will use to print your bar codes on. The reason that B-Coder allows you to select the target 
printer is because B-Coder can be configured to warn you if you try to create a bar code that will 
not be readable when printed on a particular printer. For example if the target printer has a 
resolution of 100 dots per inch (i.e., 10 mils per dot) and you try to create a bar code with a narrow 
bar width less than the width of three printer dots, B-Coder will warn you that the bar code may be 
unreadable when printed on the selected target printer. B-Coder also allows you to specify all 
dimensions for your bar codes in units of printer dots instead of inches and mils or metric units. 
Specifying all bar code dimensions in printer dots guarantees that you will end up with perfectly 
readable bar codes no matter what type of printer you will be using. 
See Also: Bar Code Dimensions and Preferences Menu Commands 
 
When you select Target Printer from the File menu, the following dialog box will appear: 
 
 

 
 
 
The values that appear by default for the horizontal and vertical dots per inch will be those of the 
currently selected default printer. If the default printer is not the printer that you intend to use and 
you know the horizontal and vertical dots per inch values for the printer that you will be using, then 
you can enter those values manually simply by typing them in. If you do not know the correct 
values for a particular printer but a Windows printer driver has been installed on your system for 
the desired printer, then you can use the Select Printer... option to select the specific printer from 
a standard Windows printer selection dialog box. When you select a printer using the Printer Setup 
option, B-Coder will automatically calculate the correct horizontal and vertical dots per inch values 
for the chosen printer. 
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The check box labeled Enable Print Resolution Warnings is used to enable or disable printer 
resolution warning messages. This option is also available in the Preferences menu. 
 
 
The File menu command Printer Setup... will open the Printer Setup dialog box for the currently 
selected default printer. The dialog box that will appear will have options that are specific to the 
currently selected printer. 
 
The File menu command Print... will print any bar code graphic that is currently displayed in the B-
Coder window. The Print... option is provided mainly so that you can test the printed output directly 
from within B-Coder. When you select this option a dialog box will appear prompting you for a Left 
and Top margin value in inches. The margin values specify exactly where on a page the bar code 
should be printed. When you print a bar code from within B-Coder, the bar code is printed as a 
Windows Metafile and therefore should produce the best output possible for whatever printer you 
are using. 
 
 
The File menu command Save Bar Code As... opens a standard Windows "File Save As..." dialog 
box so that you can save your bar code images to a disk file. B-Coder allows you to save bar 
codes in all standard graphic file formats including: .AI, .EPS, .WMF, BMP, .JPG, .PCT, .GIF, .TIF, 
.PCX as well as over a dozen other popular formats. Many graphics formats allow you to select 
various options or Preferences that affect how the image is actually stored on disk. In the “Save 
As” dialog box, there will be a check box marked “Set Preferences”. If you check this option, 
another dialog box will appear before the image is saved to disk so that you can select the various 
options available for the specific file format that you are saving your bar code in. To save a bar 
code in a particular graphics format, simply specify the file name along with the normal file name 
extension for the particular format that you want to use. For example, to save a bar code as an 
EPS file, specify a file name with the extension .EPS. 
 
Important: B-Coder initially creates all bar code graphics as Windows Metafile graphic images. 
Metafiles consist of a sequence of detailed drawing instructions that are used by Windows 
programs to reproduce a graphic image exactly as it was originally created. Because of this, 
Metafiles are both smaller and much more accurate than any other type of graphic representation. 
When you save a bar code to a disk file in a different graphics file format, B-Coder will convert the 
graphic from the original Metafile format to the specific format that you choose. Because other 
graphic formats have lower resolutions than a Metafile, images often get distorted when they are 
converted and thus may not always be readable. Also, the file size of most other image formats 
are usually much larger than an equivalent Metafile. It is highly recommended that you save your 
bar codes as Metafiles whenever possible. 
 
The command Exit in the File menu will close B-Coder's window and remove it from memory. 
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The Edit menu contains the choices: Build/Copy, Clipboard Format and Paste 
 
The Build/Copy command is used to generate a bar code from the text entered in the bar code 
text edit box in B-Coder's window. When you select Build/Copy, your bar code will be generated, 
displayed, and finally the graphic image of the bar code is copied into the Windows clipboard so 
that you can paste it into other Windows programs. 
 
Hint: Double clicking your left mouse button with the mouse cursor on any blank space in B-
Coder's window will perform the same function as selecting Build/Copy from the Edit menu..  
 
The Clipboard Format command allows you to select either Metafile, Bitmap, Device 
Independent Bitmap or All of the above as the image format for all bar codes placed in the 
clipboard. The best choice for the Clipboard Format is Metafile. If you have trouble getting a 
particular program to accept a Metafile through the clipboard, you may have to change the format 
to one of the Bitmap formats in order to get things to work.  
Note: Bitmap images have a much lower resolution than Metafiles and thus can cause the printed 
output of a bar code to be unreadable. It is highly recommended that you work with Metafiles 
whenever possible. If you use any other graphics format you should test the printed output of your 
bar codes to insure that they are readable by your bar code hardware. 
 
The Paste command pastes text from the Windows clipboard into the Bar Code Message text box 
or the Comment Line text box. Thus you can paste text strings from other programs into B-Coder. 
The Paste option will be active (not grayed) whenever there is text data in the clipboard. NOTE: 
When you create a bar code by selecting Build/Copy, the clipboard is first cleared and the graphics 
image of your bar code is placed there. After a Build/Copy operation, the clipboard will no longer 
contain text data and the Paste feature will be deactivated until another text string is "Copied" from 
another Windows program. 
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All of the commands in the Preferences menu except the Font, Foreground Color and 
Background Color commands are toggle options. Selecting any of the toggle options will switch 
the option either ON or OFF where "ON" is indicated by a check mark appearing to the left of the 
menu item. 
 
 
The Include Text option causes B-Coder to include the human readable version of your bar code 
message neatly centered along the bottom or top edge of the bar code symbol.  
Note: This option does not apply to PDF417, POSTNET, or BPO 4 State bar codes. 
 
 
The Text Above Bar Code option causes B-Coder to print the human readable version of your bar 
code message along the top edge of the bar code symbol. If this option is not selected, B-Coder 
will print the message along the bottom edge of the bar code symbol. 
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The Comment Above Bar Code option causes the comment text to be printed above your bar 
code. If this option is not selected, the comment will be printed below the bar code symbol. 
 
The Automatic Font Scaling option causes B-Coder to automatically scale all text to a font size 
that is approximately one fifth the height of the generated bar code symbol. 
 
The Font... command displays a standard font selection dialog box where you can choose the font 
for all text printed with a bar code symbol. The font selection dialog box allows you to select a font 
name, size, color and strikeout or underline effects for a chosen font. 
 
NOTE: Most bar code symbology specifications recommend the font OCR-B (Optical Character 
Recognition revision B). The choice of font is not really that important unless your bar codes are 
being used in an OCR application however it is a good idea to choose fonts that are close to the 
recommended specification. The font MS Sans Serif that comes with Windows is very close to 
OCR-B and the True Type Font Arial is also very similar.  
 
Different fonts behave differently thus some fonts may appear different on screen than when 
printed. True Type fonts are the most WYSIWYG under Windows and they also align better when 
rotated 90 or 270 degrees. 
 
Note: When the Automatic Font Scaling option is in effect, it will override any font size chosen from 
the font selection dialog box 
 
The Foreground Color and Background Color options allow you to specify the colors used for 
the bars and spaces in your bar code symbols. The Background Color option can be set to either 
Transparent or to a specific Custom Color. When you select either Foreground Color or a 
Custom Background Color, a standard Windows color selection dialog box will appear where you 
can select a desired color from a color palette. The color palette has an option allowing you to 
define custom colors by specifying exact Red, Green and Blue (RGB) color values or by specifying 
colors in terms of Hue, Saturation and Luminescence values.  
 
Note: It is entirely possible to choose color combinations that render a bar code symbol 
unreadable. The reason a bar code reader is able to read a bar code at all is because of a high 
contrast between the shades of the bars and spaces. Although two colors may appear to the 
human eye to have a high of contrast between them, a bar code reader may not be able to 
determine any difference at all between the two colors. Solid black bars on a solid white 
background always produces the best results. If you must use colors other than black on white, a 
good rule of thumb is to select solid foreground colors with a luminescence value no greater than 
60 and select solid background colors with a luminescence value no less than 180. Always test 
colored bar codes before committing to a color scheme.  
 
See Also: Bar Code Basics - How A Bar Code Reader Works 
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The Include Quiet Zones command causes B-Coder to include a small region of blank space (10 
times the width of the narrow bar elements) at either end of a bar code image. This space, called 
Quiet Zones, helps to insure that a bar code reader will be able to correctly determine the true 
beginning and end of a bar code symbol. Most bar code symbology specifications require quiet 
zones therefore it is highly recommended that you enable this option. 
 
The Include Bearer Bars command causes B-Coder to draw lines surrounding a bar code symbol. 
The purpose of bearer bars is to equalize the pressure exerted by the printing plate over the entire 
surface of the symbol. Bearer bars also enhance the reading reliability of a bar code by reduction 
of the probability of misreads or short scans which may occur when a skewed scanning beam 
enters or exits the symbol through the top or bottom edge of the bar code. When the scanner path 
leaves the symbol either through the top or bottom, it crosses the bearer bar, thereby resulting in 
an invalid start/stop code. Bearer Bars are typically used with Interleaved 2 of 5 and EAN/UCC 128 
type bar codes. 
 
The Include Code 39 / I 2 of 5 Check Character command causes B-Coder to automatically 
calculate and append a modulo 43 check character to all Code 39 bar code symbols or a weighted 
modulo 10 check character to Interleaved 2 of 5 bar code symbols. This feature should be enabled 
if the bar code reader that you are using is configured to expect a check character when reading 
Code 39 or Interleaved 2 of 5. This feature only applies to Code 39 and I 2 of 5 type bar codes. 
Code 39 with a check character is also sometimes referred to as HIBC Code (Health Industry Bar 
Code). The check character adds an extra measure of data security to a bar code symbol. 
 
The Bar Width Reduction / Gain option allows you to specify a Reduction or Gain factor ranging 
from 0% to 75%. Selecting a non-zero Bar Width Reduction or Gain causes B-Coder to reduce or 
enlarge the width of all solid bars in a bar code. Bar Width Reduction is often necessary to 
compensate for ink spread when generating bar codes that will be used in wet ink printing 
processes. The percentage that you specify is based on the narrow bar width that you choose for 
your bar codes. For example if you specify a bar width reduction of 25% and your narrow bar width 
is set at 10 mils, B-Coder will reduce the width of all solid bars in your bar codes by 2.5 mils (25% 
of 10 mils = 2.5 mils). Bar width gain is typically used when printing on glass or other surfaces that 
cause ink to bead up or shrink as it dries. 
 
The Symbol Orientation option allows you to rotate a bar code symbol in increments of 90 
degrees from horizontal. Three choices of orientation are available: Horizontal (picket fence 
orientation), Vertical 90 degrees clockwise and Vertical 270 degrees clockwise (ladder orientation).  
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The Measurement Units option allows you to select either Inches/Mils, Metric units or Printer 
Dots for all bar code dimensions. Bar code dimensions are normally expressed in Inches and Mils 
but B-Coder lets you have your choice of measurement units. When creating bar codes with very 
small dimensions, the best choice of units is Printer Dots. When bar code dimensions are 
expressed in Printer Dots, the resulting printed symbols will have the least possible chance of 
being distorted due to limitations imposed by the dot size resolution of the printer being used. (A 
printer cannot print lines narrower that the width of a single printer dot). 
 
 
The Enable Invalid Message Warnings and Enable Printer Resolution Warnings options cause 
B-Coder to warn you with a message box whenever you try to generate a bar code that does not 
conform to the rules for the currently selected symbology or when a bar code will not print correctly 
on the selected target printer. When these options are disabled, B-Coder will not prompt you with a 
warning but it will beep your PC's speaker one short beep. These options are typically disabled 
when B-Coder is being controlled by another application through the use of DDE commands. See 
Also: DDE Commands Supported By B-Coder 
 
The Fix Driver Incompatibility Problems option is used to correct printer and display driver 
incompatibility problems. B-Coder will work correctly with all video and printer drivers that come 
with Windows however some third party video drivers and some printer drivers are unable to 
display or print bar codes generated by B-Coder correctly.  
 
If a complete bar code does not appear when you print a bar code generated by B-Coder, try 
correcting the problem by enabling this option. If this problem occurs on your system, then the 
problem is with your printer driver - not with B-Coder. The best way to deal with this problem is to 
use the printer or video drivers supplied with Windows. To change video drivers, run the Windows 
Setup program in the Main program group of the Windows Program Manager and select one of the 
video drivers that were originally supplied with Windows. 
 
IMPORTANT: The Fix Driver Incompatibility Problems option should really only be used to repair 
problems with printer drivers. If your video driver is unable to display a bar code generated by B-
Coder, it does not mean that the bar code will not print out correctly on your printer. In fact, if your 
printer driver is able to print a bar code correctly without enabling this option, you may cause the 
bar code to print incorrectly if you enable it to compensate for a video driver problem.  
 
Older display drivers distributed with the Diamond Stealth VRAM or Diamond SpeedStar video 
adapters are known to have problems. Diamond Computer Systems can be reached at 408-736-
2000. Perhaps, by the time you read this, they will have updated video drivers available.  
 
 
See Also: Special Considerations and Incompatibilities 
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The SYMBOLOGY menu allows you to select a specific 
symbology for your bar codes. The currently selected 
symbology will have a check mark to the left of it's name in 
the menu.  
 
For details about each of the symbologies supported by B-
Coder see the section: Symbology Descriptions and Rules 
 
 
 
 
 

 
 
 
When you select a particular symbology, the bar code dimension data entry fields in B-Coder's 
window may change to reflect the options available for the specific symbology. 
See Also: Bar Code Dimensions and Symbology Descriptions and Rules 

 

 
The HELP menu contains the choices: Index, and About. 
 
The Index command accesses the Windows Help system and displays an index for all help topics 
available for B-Coder and the About command displays a product version number and a copyright 
notice. 
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The toolbar below B-Coder's main menu provides quick access to some of the more useful 
commands in B-Coder's main menu. Below is a summary of the main menu commands that are 
associated with each toolbar icon. Clicking your mouse on any of the tool icons in the toolbar has 
the same effect as selecting the associated command from the main menu. 
 
 
 
 

Open Configuration File

Build/Copy

Save Configuration File

Paste

Include Text
Font...

Include Quite Zones
Include Bearer Bars

Symbol Orientation
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Because of differences in the design of each bar code symbology, there are differences in the way 
that the dimensions for each symbology are expressed. When you select different symbologies 
from B-Coder's symbology menu, you will notice that some of the data entry fields for entering the 
dimensions of your bar code will change. For example, when you select Code 39, B-Coder allows 
you to specify a Bar Code Height, a Narrow Bar Width, and a Narrow To Wide Ratio. When you 
choose UPC or EAN type bar codes, B-Coder allows you to specify a Bar Code Height, a Narrow 
Bar Width, and a Magnification Factor.  
 
The two main dimensions used to define the size of most common bar codes are the Narrow Bar 
Width and the overall Bar Height. The Height is generally less important than the Narrow Bar 
Width and you can scale the height to any size that you like. For the sake of readability the height 
should not be less than a quarter of an inch or 15% of the total width of the symbol, whichever is 
greater. UPC and EAN bar codes have more specific size requirements if they are to be used for 
product identification. For details refer to UPC and EAN Magnification Factors on the following 
page. 
 
The Narrow Bar Width effectively determines the total width of a bar code symbol. All other bar 
and space width dimensions are based on this width (referred to as the nominal X dimension). The 
best choice for this dimension depends partly on the resolution of your bar code reading 
equipment and also on the resolution of the printer being used to produce the bar code.  
 
As a general rule the Narrow Bar Width should fall in a range between 10 to 30 mils and should 
never be less than 7.5 mils. For UPC and EAN bar codes, the smallest allowable Narrow bar width 
is 10.4 mils. One simple way to determine a good Narrow Bar Width is to actually print out a typical 
bar code using several different values and try reading each one with your scanning equipment. 
You should choose the value that produces bar codes with the highest "first pass" read rate. 
 

X = 1 3  S a m p l e

 

 
 

X = 2 0  S a m p l e
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Some symbologies consist of bars and spaces with only two element widths, Narrow and Wide 
Elements where the width of the wide elements is a multiple of the width of the narrow elements. 
The specifications for these symbologies allow you to choose a Narrow to Wide Element Ratio.  
 
The symbologies that support this feature are Code 39, Interleaved 2 of 5, Discrete 2 of 5, and 
Codabar. If you select one of these symbologies, a list box will appear where you can select a 
narrow to wide element ratio between 2.0 and 3.0 in increments of .1 (i.e. 2.0, 2.1, 2.2, 2.3....3.0). 
The rules for these symbologies specify that when the narrow element width is less than 20 mils, 
the narrow to wide element ratio must be 2.2 or greater. B-Coder defaults to a narrow to wide ratio 
of 2.5 and this value should be acceptable for most applications. 
 
Note: Higher quality readers may be able to successfully read bar codes with a narrow to wide 
ratio less than 2.2 no matter what the narrow element width is. Lower quality readers often need a 
ratio of at least 2.5 in order to read correctly. Because of the great variability between readers, you 
should always experiment with different ratio values and select the value that produces bar codes 
with the best successful read rate. 
 
 

 
UPC and EAN bar codes are defined with a standard, fixed, narrow element width of exactly 13 
mils; however, the specifications for these symbologies allows for a magnification factor of 
between 80% and 200%. This translates to an allowable range of narrow element widths of 
between 10.4 and 26 mils. 
 
When you select either of these symbologies a text box will appear where you can specify the 
magnification factor as a percentage of the standard element width (80% to 200%). 
 
See Also: 
 
Bar Code Symbology Descriptions & Rules (UPC and EAN) 
How To Produce Readable Bar Codes. 
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Although there are many different types of bar codes, they all share the same requirements in 
order to be readable by most commercially available scanning devices. Because a beam of light is 
used to read a bar code, it should be clean and free of defects or smudges and there should be a 
high contrast between the color of the bars and the color of the spaces. Black bars on a white 
background yield the best results. If you intend to use colored bar codes or colored paper, you 
should always test the readability of your bar codes before committing to a color scheme.  
 
Another important consideration is that there should always be a small amount of space or Quiet 
Zones preceding and following the bar code so that the reading device is able to properly 
determine the true start and end of the bar code symbol. A good rule of thumb is to reserve at least 
a quarter of an inch or 10 times the width of a single narrow bar (whichever is greater) for blank 
space at either end of a bar code. B-Coder will automatically include Quiet Zones of ten times the 
narrow bar width if the "Include Quiet Zones" option is enabled in the Preferences menu. 
 
When printing bar codes, laser, ink jet and thermal transfer printers produce the best results. Dot 
matrix printers produce the poorest quality (but not necessarily unacceptable) bar codes. Dot 
matrix printers are especially poor when the bar code dimensions are set to a small size. You 
should try to avoid very small or very large bar codes, both narrow bar widths and overall bar code 
dimensions. As a precaution you should always test your printed output with whatever bar code 
reading equipment you eventually intend to use. 
 
B-Coder can be configured to display a warning message if the specified Narrow Bar Width will be 
smaller than three printer dots for a particular printer. You can select a specific target printer or 
printer resolution and also enable Printer Resolution Warning Messages using the Target 
Printer... command in the File menu. 
 
 
See Also:  
 
Symbology Descriptions and Rules 
Special Considerations And Incompatibilities 
Bar Code Basics 
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Bar code is an automatic identification technology that allows data to be collected rapidly and with 
extreme accuracy. Because of this, bar code technology is finding its way into a broad range of 
applications in almost every sector of business. Bar codes provide a simple and easy method of 
encoding text information that is easily read by inexpensive electronic readers. A bar code consists 
of a series of parallel, adjacent bars and spaces. Predefined bar and space patterns or 
symbologies are used to code character data into a printed symbol. Bar codes can be thought of 
as a printed version of the Morse code with narrow bars representing dots, and wide bars 
representing dashes. A bar code reading device decodes a bar code by scanning a light source 
across the bar code and measuring the intensity of light reflected back to the device. The pattern 
of reflected light produces an electronic signal that exactly matches the printed bar code pattern 
and is easily decoded into the original data by inexpensive electronic circuits. Due to the design of 
most bar code symbologies it does not make any difference if you scan a bar code from right to left 
or from left to right. 
  
Shown Below is the structure of a typical bar code symbol. 
 

Q
U

IE
T 

ZO
N

E

Q
U

IE
T 

ZO
N

E

Start StopCheck1 3
 

 
The basic structure of a bar code consists of a leading and trailing quiet zone, a start pattern, one 
or more data characters, optionally one or two check characters and a stop pattern. 
 
 
There are a variety of different types of bar code encoding schemes or "symbologies", each of 
which were originally developed to fulfill a specific need in a specific industry. Several of these 
symbologies have matured into de-facto standards that are used universally today throughout 
most industries. The symbologies supported by B-Coder are those most commonly used across all 
industries. For more information about specific bar code symbologies supported by B-Coder see: 
Symbology Descriptions And Rules  
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A bar code reader works by scanning a dot of light across a bar code symbol. As the dot scans 
across the bar code, light is reflected back to the bar code reader by the light areas and is 
absorbed by the dark areas. The scanner electronically measures the intensity of the light reflected 
back to produce a digitized waveform that can be decoded back to the original message similar to 
the way morse code dots and dashes are decoded. 
 

Dot Of Light

Digitized Signal
 

 
 
 
 
The factors that make a bar code readable are: an adequate print contrast between the light and 
dark bars and having all bar and space dimensions within the tolerances for the symbology. It is 
also helpful to have sharp bar edges, few or no spots or voids, a smooth surface and clear margins 
or quiet zones at either end of the printed symbol. 
 
 
Bar code scanners can be purchased with different resolutions to enable them to read bar codes 
of different sizes. The scanner resolution is measured by the size of the dot of light. The dot of light 
should be equal to or slightly smaller than the narrowest element width ("X" dimension). If the dot 
is wider than the width of the narrowest bar or space, then the scanner can get confused due to 
the dot overlapping two or more bars at a time. If the dot is too small, then any spots or voids in the 
bars can be misinterpreted as light areas thus making a bar code unreadable.  
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B-Coder has been thoroughly tested with a wide variety of Windows application programs as well 
as different printing devices and has been found to produce extremely high quality bar codes. 
There are a few minor incompatibilities with some programs but fortunately most of these problems 
have simple solutions. Three general types of problems have been identified as listed below and 
are outlined in further detail in the following pages. 
 
Pasting Bar Codes into Word, Excel and PageMaker 
Pasting Bar Codes Into Programs That Work With Bitmaps. 
Pasting Bar Codes Into A Spreadsheet. 
Printing Bar Codes On A Dot Matrix Printer. 
 
 
See Also: How To Produce Readable Bar Codes. 
 
 

 
 
When you create a bar code in B-Coder, a Windows MetaFile is placed in the clipboard so that you 
can paste the bar code into other windows programs. Starting in Windows 95, Microsoft has added 
a new MetaFile format called the "Enhanced MetaFile" or "EMF" format. The new EMF format is 
supposed to be compatible with the standard WMF file format however there are some inherent 
technical problems with the EMF format that make it less than ideal for creating bar codes. 
 
Most 32 bit Windows programs (including Word for Windows and Pagemaker) support both the 
WMF and the EMF file formats however some 32 bit programs (i.e. Word and all 32 bit versions of 
Pagemaker) automatically convert any metafile found in the clipboard to an Enhanced MetaFile. 
When you paste bar codes from B-Coder into these programs by selecting "Paste" from their EDIT 
menu, the bar code will be converted to an Enhanced MetaFile and subsequently will not print 
correctly. For these applications you must select "Paste Special" and choose either "Picture" or 
"MetaFile" (instead of "Enhanced MetaFile") in the "Paste Special" dialog box as the format. 
Unfortunately Excel 97 does not support pasting metafiles that are not "Enhanced Metafiles" 
however it will allow you insert metafiles from a disk file as long as the Windows Metafile graphics 
import filter was installed when you originally installed Excel on your computer. This means that to 
add bar codes to an Excel 97 worksheet, you must save your bar codes to a disk file using the 
WMF file format and then use the "Insert Picture From File" menu option in Excel to read the 
metafile from the disk file into the sheet. 
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When cutting and pasting bar codes from B-Coder into other programs, the best graphics format to 
use is the Metafile format. Metafile images are scaleable images that consist of drawing 
instructions used internally by Windows to reproduce an image in a manner that uses the highest 
resolution of the device that the image is being printed on. Because most printers have a much 
higher resolution than most computer monitors, the printed version of a MetaFile will almost always 
have a much higher degree of detail than the same image when it is displayed on your computer's 
monitor. Bitmaps on the other hand do not automatically use the highest resolution possible when 
printed and therefore the printed output of a bitmap will retain the same (lower) quality as that of 
your monitor.  
 
When you paste a Metafile bar code produced by B-Coder into a graphics or drawing program that 
only has the capability of working with bitmap files (.BMP) such as the PaintBrush program that 
comes with Windows, your bar code will be automatically converted from a Windows Metafile 
format to a bitmap format. During this conversion process, the bar code will most likely be 
deformed and thus it may be unreadable when it is eventually printed. A possible solution to this 
problem is to increase the Narrow Bar Width value and avoid the use of any scaling features in the 
target application (i.e. SHRINK & GROW in PaintBrush). Acceptable bar codes can be produced 
with these types of programs but their output should always be tested for readability. 

 
A minor problem with spreadsheets is that they normally display and print a grid pattern around all 
cells. Cell grid lines can be confused by a bar code reader as part of a bar code. This problem can 
easily be corrected simply by turning grid lines off before printing the spreadsheet. In Excel this is 
done by selecting "Options" and "Display..." from Excel's main menu and then clearing the "Grid 
lines" check box. 
 
Another small problem is that most spreadsheet programs will automatically draw a border around 
images both while displayed on screen and when printed on a printer. If there is no leading or 
trailing "Quiet Zone" at either end of your bar code, the border appears to a bar code reader as 
part of the bar code and thus it will probably be unreadable. The easiest way to avoid this problem 
is to enable the Include Quiet Zones option in B-Coder's Preferences menu. Another solution is to 
remove the unwanted border with a formatting command in the spreadsheet. In Microsoft Excel 
you can get rid of borders around graphics by selecting "Format" & "Patterns" from Excel's main 
menu. This will display a dialog box where you can instruct Excel to remove a border from a 
selected graphic. 
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Dot matrix printers offer the lowest resolution of all available printers. Although dot matrix printer 
manufacturers claim resolutions as high as 360 dots per inch, the real resolution of most is only 60 
dots per inch. Higher resolutions are simulated by overlapping consecutive dots. The reason that 
the true resolution is only 60 dots per inch is because the width of each dot is approximately 1/60th 
of an inch (16 mils). In order to print readable bar codes on a dot matrix printer, the Narrow Bar 
Width must never be less than the width of a printer dot as it is impossible for a dot matrix printer 
to print a line narrower than the width of a single dot. The larger the value that you choose for the 
Narrow Bar Width (within the allowable range for a specific symbology), the more readable your 
bar codes will be. 
 
When you set up the Windows printer driver for your dot matrix printer you should select the 
highest dot resolution that the printer is capable of. If the driver has a Dithering option, you should 
also select "Line Art" or the finest dithering resolution that is supported. Some dot matrix drivers 
also allow you to set the intensity or darkness of the printing. If your printer supports this feature, 
you should set the intensity to the darkest level supported. 
 
Finally, you should always test bar codes printed on a dot matrix printer. 
 
See Also: How To Produce Readable Bar Codes 
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The Normal CODE 39 is a variable length symbology that can encode the following 44 characters: 
1234567890ABCDEFGHIJKLMNOPQRSTUVWXYZ-. *$/+%. Code 39 is the most popular 
symbology in the non retail world and is used extensively in manufacturing, military, and health 
applications. Each Code 39 bar code is framed by a start/stop character represented by an 
asterisk (*). The Asterisk is reserved for this purpose and may not be used in the body of a 
message. B-Coder automatically adds the start and stop character to each bar code therefore you 
should not include them as part of your bar code message. If you select the NORMAL version of 
CODE 39 and your bar code text contains lower case characters, B-Coder will convert them to 
upper case. If your bar code message contains any invalid characters, B-Coder will prompt you 
with a warning message (if the Enable Invalid Warning Messages option is selected in the 
Preferences menu). 
 
 
Code 39 optionally allows for a (modulo 43) check character in cases where data security is 
important. The health care industry has adopted the use of this check character for health care 
applications. To enable the Code 39 check character feature in B-Coder, select the option 
INCLUDE CODE 39 / I 2 of 5 CHECK CHARACTER in B-Coder's Preferences menu. When this 
option is enabled, B-Coder will automatically calculate and append the proper check character to 
all Code 39 symbols. 
 
Another feature of Code 39 allows for concatenation of two or more bar codes. It is sometimes 
advantageous to break long messages into multiple, shorter, symbols. If the first data character of 
a Code 39 symbol is a space, some readers will store the remainder of the symbol in a buffer and 
not transmit the data. This operation continues for all successive Code 39 symbols with a leading 
space, with each message appended to the previous one. When a message without a leading 
space is read, it is appended to the previously scanned data in the buffer and the entire buffer is 
transmitted as one long message. 
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The FULL ASCII version of Code 39 is a modification of the NORMAL (standard) version that can 
encode the complete 128 ASCII character set (including asterisks). The Full ASCII version is 
implemented by using the four characters: $/+%. as shift characters to change the meanings of the 
rest of the characters in the Normal Code 39 character set. Because the Full ASCII version uses 
shift characters in combination with other standard characters to represent data not in the Normal 
Code 39 character set, each non-standard character requires twice the width of a standard 
character in a printed symbol. The table below shows the character combinations used to produce 
the Full ASCII version of Code 39. 
 
ASCII  CODE 39   ASCII    CODE 39   ASCII   CODE 39    ASCII    CODE 39 
NUL %U SP SPACE @ %V ` %W 
SOH $A ! /A A A a +A 
STX $B " /B B B b +B 
ETX $C # /C C C c +C 
EOT $D $ /D D D d +D 
ENQ $E % /E E E e +E 
ACK $F & /F F F f +F 
BEL $G ' /G G G g +G 
BS $H ( /H H H h +H 
HT $I ) /I I I i +I 
LF $J * /J J J j +J 
VT $K + /K K K k +K 
FF $L , /L L L l +L 
CR $M - - M M m +M 
SO $N . . N N n +N 
SI $O / /O O O o +O 
DLE $P 0 0 P P p +P 
DC1 $Q 1 1 Q Q q +Q 
DC2 $R 2 2 R R r +R 
DC3 $S 3 3 S S s +S 
DC4 $T 4 4 T T t +T 
NAK $U 5 5 U U u +U 
SYN $V 6 6 V V v +V 
ETB $W 7 7 W W w +W 
CAN $X 8 8 X X x +X 
EM $Y 9 9 Y Y y +Y 
SUB $Z : /Z Z Z z +Z 
ESC %A ; %F [ %K { %P 
FS %B < %G / %L : %Q 
GS %C = %H ] %M } %R 
RS %D > %I  ̂ %N ~ %S 
US %E ? %J _ %O DEL %T,%X,%Y,%Z 
 
Note: Because all of the characters used to implement Full ASCII Code 39 are part of the Normal 
Code 39 character set, readers that do not support Full ASCII Code 39 will still read Full ASCII 
Code 39 symbols. The reader will output shifted characters as if they were normal Code 39 
characters. For example the following string: B-CODER=FUN will be read as: 
B-CODER%HFUN by a reader that only supports Normal Code 39. Instead of converting the Full 
ASCII encoded characters %H to an equal sign, the reader blindly outputs %H. 
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    UPC-A  with Supplemental       UPC-E 

   
 
UPC-A is a 12 digit, numeric symbology used in retail applications. UPC-A symbols consist of 11 
data digits and one check digit. The first digit is a number system digit that usually represents the 
type of product being identified. The following 5 digits are a manufacturers code and the next 5 
digits are used to identify a specific product. 
 
UPC numbers are assigned to specific products and manufacturers by the Uniform Code Council 
(UCC). To apply for a UPC number or for more information, you can contact the UCC at 8163 Old 
Yankee Road, Suite J, Dayton, OH  45458  Tel: 513-435-3870 
 
When specifying UPC-A messages, you may enter up to 11 digits. B-Coder will automatically 
calculate the check digit for you. If you enter less than 11 digits or if you enter any digits other than 
0 to 9, B-Coder will prompt you with a warning message. If the option “Enable Invalid Message 
Warnings” in the Preferences menu is not selected and you do not enter 11 digits, B-Coder will left 
pad short messages with zeros and truncate longer messages so that the total length is 11.  
 
UPC-E is a smaller, six digit, UPC symbology for number system 0. It is often used for small retail 
items. UPC-E is also called "zero suppressed" because UPC-E compresses a normal 12 digit 
UPC-A code into a six digit code by "suppressing" the number system digit, trailing zeros in the 
manufacturers code and leading zeros in the product identification part of the bar code. A seventh 
check digit is encoded into a parity pattern for the six main digits. UPC-E can thus be 
uncompressed into a standard UPC-A 12 digit number. 
 
For UPC-E bar codes, you may enter up to 6 digits. Again, B-Coder will calculate the check digit 
and truncate or pad the number to a total length of 6 digits as with UPC-A.  
 
Both UPC-A and UPC-E allow for a supplemental two or five digit number to be appended to the 
main bar code symbol. This supplemental message was designed for use on publications and 
periodicals. If you enter a supplemental message, it must consist of either two or five numeric 
digits. The supplemental is simply a small additional bar code that is added onto the right side of a 
standard UPC symbol. 
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  EAN-8          EAN-13 with supplemental (ISBN Version) 

   

5 2 9 9 5

9  7 8 1 5 6 2  7 6 0 0 8 3   

   ISBN 1-56276-008-4

 
 
EAN or European Article Numbering system (also called JAN in Japan) is a European version of 
UPC. It uses the same size requirements and a similar encoding scheme as for UPC codes.  
 
EAN-8 encodes 8 numeric digits consisting of two country code digits, five data digits and one 
check digit. B-Coder will accept up to 7 numeric digits for EAN-8. B-Coder will automatically 
calculate the check digit for you. If you enter less than 7 digits or if you enter any digits other than 
0 to 9, B-Coder will display a warning message. If the option “Enable Invalid Message Warnings” in 
the Preferences menu is not selected and you do not enter 7 digits, B-Coder will left pad short 
messages with zeros and truncate longer messages so that the total length is 7.  
 
EAN-13 is the Euro version of UPC-A. The difference between EAN-13 and UPC-A is that EAN-13 
encodes a 13th digit into the parity pattern of the left six digits of a UPC-A symbol. This 13th digit, 
combined with the 12th digit, usually represent a country code. 
 
Both EAN-8 and EAN-13 support a supplemental two or five digit number to be appended to the 
main bar code symbol. The supplemental is designed for use on publications and periodicals. 
Supplemental messages must consist of either two or five numeric digits and will appear as a 
small additional bar code on the right side of a standard EAN symbol. 
 
EAN bar code numbers are assigned to specific products and manufacturers by an organization 
called ICOF located in Brussels, Belgium. Tel: 011-32-2218-7674 
 
EAN-13 has been adopted as the standard in the publishing industry for encoding ISBN numbers 
on books. An ISBN or BookLan bar code is simply an EAN-13 symbol consisting of the ISBN 
number preceded by the digits 978. The supplemental in an ISBN bar code is simply the retail 
price of the book preceded by the digit 5. For example, if your ISBN number is 1-56276-008-4 and 
the price of the book is $29.95 then you would enter 978156276008 as the bar code message and 
52995 for the supplemental. If you choose BookLan as the bar code symbology, B-Coder will 
automatically create the correct EAN-13 bar code if you supply just the first 10 digits of the ISBN 
number and optionally a price (without the preceeding 5). 



 31 

 

 

 
 
Interleaved 2 of 5 is a high density variable length numeric only symbology that encodes digit pairs 
in an interleaved manner. The odd position digits are encoded in the bars and the even position 
digits are encoded in the spaces. Because of this, I 2 of 5 bar codes must consist of an even 
number of digits. Also, because partial scans of I 2 of 5 bar codes have a slight chance of being 
decoded as a valid (but shorter) bar code, readers are usually set to read a fixed (even) number of 
digits when reading I 2 of 5 symbols. The number of digits are usually pre-defined for a particular 
application and all readers used in the application are programmed to only accept I 2 of 5 bar 
codes of the chosen length. Shorter data can be left padded with zeros to fit the proper length. B-
Coder will only accept numeric digits for I 2 of 5 bar codes. If an odd number of digits is entered, B-
Coder will Left-Pad one zero to the number entered. 
 
Interleaved 2 of 5 optionally allows for a weighted modulo 10 check character for special situations 
where data security is important. To enable the I 2 of 5 check character feature in B-Coder, select 
the option INCLUDE CODE 39 / I 2 of 5 CHECK CHARACTER in B-Coder's Preferences menu. 
When this option is enabled, B-Coder will automatically calculate and append the proper check 
character to all Interleaved 2 of 5 symbols. 
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POSTNET (POSTal Numeric Encoding Technique) is a 5, 9 or 11 digit numeric only bar code 
symbology used by the U.S. Postal Service to encode ZIP Code information for automatic mail 
sorting by zip code. The bar code may represent a five digit ZIP Code (32 bars), a nine digit ZIP + 
4 code (52 bars) or an eleven digit Delivery Point code (62 bars).  
 
POSTNET is unlike other bar codes because data is encoded in the height of the bars instead of in 
the widths of the bars and spaces. Most standard bar code readers cannot decode POSTNET. 
This symbology was chosen by the Postal Service mainly because it is extremely easy to print on 
almost any type of printer. POSTNET is a fixed dimension symbology meaning that the height, 
width and spacing of all bars must fit within exact tolerances.  
B-Coder will only create POSTNET bar codes that follow the guidelines published by the Postal 
Service. B-Coder does not allow direct control over the size of POSTNET bar codes. 
NOTE: Most other Windows programs allow you to modify the size of metafile graphic images 
pasted from the clipboard. If you change the size of a POSTNET bar code even by a small 
amount, it will be completely unreadable by the Postal Service bar code readers. 
 
B-Coder will ignore non-numeric data in any bar code message that you enter for POSTNET. For 
example, if you enter "Chicago, IL 60601-3222" for a POSTNET bar code message,  
B-Coder will still create a correct bar code. This feature allows you to cut an address line from 
another Windows program and paste it into B-Coder without having to edit the bar code text. 

 
FIM or Facing Identification Mark patterns are another type of postal bar code used in automated 
mail processing by the U.S. Postal Service. FIM patterns are used for automatic facing and 
canceling of mail that does not contain a stamp or meter imprint (business reply mail, penalty mail, 
etc.). They also provide a means of separating business and courtesy reply mail from other letters. 
Three FIM patterns are currently in use. FIM-A is used on courtesy reply mail that has been 
preprinted with Postnet bar codes. FIM-B is used on business reply, penalty and franked 
(government) mail that is not preprinted with Postnet bar codes. FIM-C is used on business reply, 
penalty and franked mail that has been preprinted with Postnet bar codes. FIM patterns are placed 
in the upper right corner along the top edge and two inches in from the right edge of letters and 
cards. For more information about all postal bar codes contact your local post office. 
 
When you select a FIM pattern from the symbology menu, B-Coder will immediately generate the 
requested pattern without switching from the currently selected symbology and without having to 
select Build/Copy from B-Coder's Edit menu. 
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There are essentially three main types of bar code readers currently available: Bar Code Wands or 
Pen type readers, CCD type bar code readers, and Bar Code Laser Scanners. Each of the three 
types of readers have their own specific advantages and disadvantages.  
 
 

 
Bar Code Wands are the smallest and least expensive of the three main reader types typically 
ranging in price between $200 to $400. Wands are pen shaped devices that use an LED light 
source mounted at the tip of the "pen". To read a bar code, the wand must be physically dragged 
across the bar code in a smooth steady motion. Because the tip of the wand is usually in contact 
with the bar code symbol, there is a good chance that the bar code image will get scratched or 
damaged if it is read with a wand repeatedly. Another disadvantage with wands is that it can be 
difficult to read bar codes printed on irregular shaped objects like cans or bottles. Wands are a 
good choice when all your bar codes are printed on flat surfaces and the number of times that 
each bar code is to be read is low and when size, price and power consumption are major 
considerations. Wands are typically used in the Video Rental and Air Parcel business. 

 
CCD readers are the next step above bar code wands in both price and performance. CCD 
readers use an array of sensors approximately 2 to 4 inches wide to read a bar code. Because of 
this, CCD readers are limited to reading bar codes that have an overall width that is less than the 
width of CCD sensor array. Typical prices for CCD readers are between $400 and $800. They are 
non contact devices meaning that they do not damage a bar code during the reading process but 
they must be held within a few inches of a bar code in order to read successfully. CCD readers 
have better success than wands when reading bar codes printed on irregular shaped surfaces. 
CCD readers are a good choice when reading small to medium sized bar codes that might be 
printed on irregular surfaces. CCD readers are typically used in retail Point of Sale applications. 
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Laser scanners are the most expensive types of bar code readers because they use a moving 
laser beam to perform a read. Like CCD readers laser scanners are non contact devices but laser 
scanners are capable of reading a much wider range of bar code sizes over a wider range of 
distances. Laser scanners come in two varieties, hand held and fixed mount. Hand held laser 
scanners look similar to CCD readers but are usually smaller and narrower. Most hand held 
scanners use a trigger to activate a reciprocating mirror that rapidly scans the laser beam across 
the surface of a bar code. Hand held laser scanners must be aimed at a bar code so that the 
moving laser beam scans across the entire bar code perpendicular to the bars and spaces. The 
most common type of fixed mount laser scanners are the kind used in grocery store check out 
lines. Fixed mount readers use a sophisticated scanning system that rapidly scans the laser beam 
in many directions so that the orientation of a bar code does not matter. This allows for extremely 
rapid reading of many different sized bar codes printed on different shaped objects. Hand held 
laser scanners are typically priced between $800 and $2000 and fixed mount scanners start at 
about $800 and go up from there. Laser scanners are excellent for all bar code applications but 
they really excel when speed or distance is a major factor and when very long bar codes must be 
read. The only drawback to laser scanners is that they consume the most power of all the three 
main types of bar code readers. 
 

 
The traditional way to connect a bar code reader to a PC is to use a device called a Keyboard 
Wedge that plugs into the keyboard port of a PC. The keyboard and the bar code reader are then 
plugged into the Wedge so that the PC receives data from both devices as keystrokes. Keyboard 
wedges are fine for simple DOS based applications but they have several major drawbacks. They 
cannot be used on a laptop PC that does not have a keyboard port, they cannot handle large 
amounts of data such as data from a PDF417 bar code symbol, and they do not work well under 
multitasking operating systems like Windows or OS/2. With a keyboard wedge, the program that is 
being used to collect the bar code data must be running in the foreground and thus the PC cannot 
be used for any other purpose while the bar code reader and the keyboard wedge are being used.  
 
To solve these problems TAL Technologies has developed a product called WinWedgeTM that 
allows a bar code reader to be connected to a PC's serial port. The WinWedgeTM is a software only 
solution that performs the exact same function as a Keyboard Wedge except that it has far more 
capabilities including the ability to handle large amounts of data and the ability to transfer data to a 
program that is running in the background (minimized) under Windows or OS/2. Other features 
include date/time stamping, the ability to capture data directly to a disk file, parsing and filtering 
functions, keystroke macro insertion, and data translation capabilities. WinWedgeTM is not only 
better than a keyboard wedge, it is also much less expensive. 
WinWedgeTM is by far the best solution for interfacing a bar code scanner to a PC. 
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